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www.delcam-ams.com 

 

Whether you are a new or long-term user of Delcam products, you 
may not be aware of the complementary technologies available 
from Delcam that could improve your company’s productivity. 

 

Delcam Advanced Manufacturing Solutions offers a complete and 
diverse range of CADCAM software solutions to integrate every 
aspect of your production life-cycle – from designing a complex 
concept, to manufacturing it and inspecting the final output – 
providing you with unrivalled speed, flexibility, and ease-of-use 
throughout your product development process. 

 

Adding to your suite of Delcam solutions minimises the impact on 
your daily production operations while also enabling you to enter 
new markets or automate your processes with our advanced 
functionality. 

 

All products work independently or together as one complete 
manufacturing solution tailored to your specific needs. 

 
  

Powering your productivity 



 

 

 
www.powershape.com 

PowerSHAPE provides a complete environment to manipulate 
surface form, build from wireframe, and add solid features for 
prismatic parts. 

 Import/export Parasolid-based systems with no translation. 

 Create complex molds from solid models, complete with split 
surfaces. 

 Powerful surface- and face-editing tools quickly repair imported 
data. 

 Tools to perform non-feature-based edits quickly and efficiently. 

 

 
www.powermill.com 

PowerMILL is the world’s leading specialist NC CAM software for the 
manufacture of complex shapes, providing advanced-machining 
strategies to minimise machining time and maximise finish quality. 

 World-leading high-speed machining strategies. 

 Advanced 5-axis machining techniques. 

 Support for 64-bit platforms and multi-threading. 

 Innovative collision-avoidance methods. 

 Powerful toolpath editing and tool-axis stabilisation. 

 

 
www.featurecam.com 

FeatureCAM is a unique CAM system that uses feature-based and 
knowledge-based technologies for automated machining, minimising 
programming times for mills, lathes, turn/mill, and wire machines. 

 Easy to use. 

 Single interface for multiple machine platforms. 

 Powerful turning and milling operations from 2.5D to 5-axis. 

 Multi-threading capabilities. 

 



 

 

 

 

www.delcamforsolidworks.com 

Delcam for SolidWorks is a SolidWorks Certified Gold Product that 
revolutionises CAM programming inside SolidWorks. 

 Integrates the feature-based technology from FeatureCAM. 

 Multi-threaded toolpath algorithms from PowerMILL. 

 2-axis, 3-axis, and 5-axis positional milling and drilling. 

 Turning, turn/mill, and wire EDM capabilities. 

 Automatic selection of cutting tools, machining strategies, and 
feeds and speeds. 

 Exceptional toolpath-calculation speeds. 

 Set-up wizards. 

 Full-machine simulation. 

 

 
www.partmaker.com 

PartMaker applies a patented Visual Programming approach to 
automate the programming of multi-axis Swiss-type lathes and 
Turn-Mill Centres. 

 Easier programming of turning with live tooling via the Divide-
and-Conquer programming approach. 

 Automatic process synchronisation. 

 Vivid 3D simulation and crash detection. 

 Wide array of proven post processors for Turn-Mill Centres and 
Swiss-type lathes. 

  



 

 

 
www.powerinspect.com 

PowerINSPECT leads the way in today’s inspection market. It 
delivers a complete CAD-based inspection solution that can accept 
data from all types of hardware, including manual and CNC 
coordinate measuring machines, portable arms, optical measuring 
devices, and CNC machine tools. 

 Part comparison against all mainstream CAD formats. 

 Support for all types of measuring devices. 

 Market-leading inspection reports that are quick to create and 
easy to understand. 

 IGES export of measured features, including digitized curves. 

 Additional modules for part alignment, laser line inspection, and 
tube inspection. 

 

 

www.artcam.com 

ArtCAM is a unique application that combines the benefits of 
computerised design and CNC machining in a simple-to-use format 
to create decorative products from artwork. 

 Import 3D models, clipart, and other CAD system formats. 

 Add geometric shapes, weaves, and textures. 

 Choose from extensive visualisation and rendering materials. 

 Use the comprehensive and customisable tool database for fast 
toolpath-calculation. 

 Powerful toolpath simulation verifies machining times and 
materials. 

 Design in the 3D view. 

 

Delcam also provides a range of healthcare CADCAM solutions for 
the dental, custom orthotic insoles, medical implants, and 
orthopaedic footwear industries, as well as CADCAM solutions for 
footwear design and manufacturing. 

 

You can connect with Delcam in a variety of ways: 
visit: www.delcam.com | watch: www.delcam.tv | learn: www.delcam.tv/lz 
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Delcam plc has no control over the use made of the software 
described in this manual and cannot accept responsibility for any 

loss or damage howsoever caused as a result of using the software. 
Users are advised that all the results from the software should be 

checked by a competent person, in accordance with good quality 
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PowerMILL is the leading NC CAM software specialising in the 

manufacture of complex shapes typically found in the toolmaking, 
automotive, and aerospace industries. PowerMILL 2014R2 offers all 

of the original features of PowerMILL 2014, but with numerous 
improvements. This document describes the most significant 

improvements. 
 

Toolpath preparation 
There is a new composite curve creator which greatly enhances 
2.5D machining and flowline machining (see page 3). 

There is now a separate dialog for hole creation and editing. This 
simplifies the Feature dialog as it no longer contains the hole specific 

options. 

 There is an improved process for hole creation because it is 

significantly different to the creation of other features (see page 
36). There is now a separate dialog for hole creation so the 
Feature dialog no longer contains the hole specific options. 

 There is a new dialog to control hole editing and hole 
intersections (see page 44). 

 There are several changes to the Feature Set and individual 
feature set menus (see pages 59–60). 

 You can now see a history of your boundary edits. This is similar 
to the history of your toolpath edits (see page 64). 

You can now see a history of your boundary edits (see page 64).  

There are improvements to specifying the tool stock material (see 

page 68). 
 

Toolpath generation 
When drilling compound holes, you can now choose which hole 
components you want to drill (see page 71). 

When creating a drilling method, you can now add an existing 
drilling toolpath and notes (see page 70). 

 

Summary of new features 
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Advanced simulation 
The new Dynamic machine control mode enables you to simulate and 

adjust the configuration and tool axis of a 3+2 machine tool, so you 

can quickly and easily improve the machine tool's access to the 
workpiece (see page 72). 

 

Toolpath output 
There are several improvements to NC programs functions. You can 

now: 

 Multi-select NC programs (see page 85). 

 Draw all the toolpaths used in an NC program (see page 85). 

 Add toolpaths to the NC program multiple times (see page 86). 

 Create fixture offset more easily (see page 70). 
 

User interface 
The new Machine Tool Position and Collision dialogs replace the 

Machine Information dialog (see page 87). 

The new dialogs: 

 Improve the presentation of machine tool position and collision 

data. 

 Enables easier jogging of a machine tool’s axes. 
 

Automation 
There are enhancements to the macro programming language (see 

page 91). 
 

General enhancements 
There is an improved process for creating and managing custom 

toolbars. In PowerMILL 2014R2 you can have up to thirty-two 
custom toolbars at any time (see page 92). 
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Composite curve creator 
There is a new composite curve creator which greatly enhances 

2.5D machining and flowline machining. 

The Create Composite Curve mode toolbar merges adjacent arcs, 

lines, curves, and surface edges into one composite curve. This 

offers very similar functionality to PowerSHAPE's composite curve 
creator. 

Selecting  displays the Create Composite Curve mode toolbar. 

 

 is available from: 

 the Curve Creation toolbar on the Curve Editor mode toolbar 

 

 the Pattern toolbar 

 the Boundary toolbar 

 Activating a mode disables most of PowerMILL's functionality 
until you exit from the mode. For more information, see Mode 

toolbars. 

You build a composite curve from existing geometry, starting by 

selecting a curve (see page 8) or surface (see page 10). Where you 
select the curve or surface determines the default direction. Then 

the options enable you to guide the path of the curve to create the 
required composite curve. 

The Create Composite Curve toolbar works on curves (not 

surfaces). If a surface is in an area of interest, it selects the surface 
edge curve and operates on that. This edge curve is always a 

complete closed loop that goes all the way around the perimeter of 
the surface. 

Toolpath preparation 
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 Surface marker — Click to display the surface markers. 

 deselected: 

 

 selected: 

 

  Surface selection point 

The surface markers use the same colour scheme as the curve 
selection: 

 Pink indicates the surface edge automatic sketching follows. 

 Yellow indicates alternate surface edges. 

 Blue indicates the current surface for the current curve. 

 Grey indicates an alternative surface for the current curve. This 
is an option you are unlikely to use because it returns to the 

start point, but along the other surface. For more information, 
see Selecting curves to create a composite curve (see page 8). 
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 Reset — Click to go back to the start and deselect all curves. It 
still displays the Create Composite Curve mode toolbar. 

 Marker point 1 — When sketching a composite curve, click  

and then click on a curve to specify the marker point. The marker 

points prevent the composite curve progressing beyond this point 
(see page 27). 

 If the composite curve doesn't meet this marker point, the 
marker point has no effect on the composite curve. 

 Rewind — Click to go back to either the previous branch point, 

or the beginning (if no branch points exist). 

Starting with: 

 

Clicking  gives: 
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 Backward — Click to go back to the previous curve. This takes 

you back to where two or more curves meet, so it may not take you 

back as far as the previous branch point. 

Starting with: 

 

Clicking  gives: 

 

 Forward — Click to proceed to either the next branch point, or 

the end (if no branch points exist). 

 Fast Forward — Click to proceed along the automatic path as far 

as possible. 
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 Marker point 2 — When sketching a composite curve, click  

and then click on a curve to specify the marker point. The marker 

points prevent the composite curve progressing beyond this point 
(see page 27). 

 If the composite curve doesn't meet this marker point, the 
marker point has no effect on the composite curve. 

 Reverse — Click to change the direction of the curve. 

Starting with: 

 

Clicking  gives: 

 

 

 

 

  Start point 

  Curve direction 
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 Save and Restart — Click to save the current selection as a 
composite curve. This still displays the Create Composite Curve mode 

toolbar, so you can create another composite curve in this pattern 
or boundary. 

 Direction — Hover over the button to display the Direction 

toolbar. The option you select determines the default direction at a 

branch point. When PowerMILL encounters a branch point, the 
composite curve creator displays the choices using an arrow and 

colour (see page 12). 

 Composite curve creator options — Click to raise the Options 

dialog with the Composite curve creator page displayed (see page 

31). 

 Accept changes — Click to accept the current composite curve. 
This returns you to the Curve Editor mode toolbar. 

 Cancel changes — Click to delete the current composite curve. 
This returns you to the Curve Editor mode toolbar. 

 

Selecting curves to create a composite curve 

When the Create Composite Curve mode toolbar is displayed, where 

you select the curve affects the default direction of the composite 

curve. 

The forward direction points to the curve-end closest to the 

selection point. So, selecting the curve at point , gives a forward 

direction of upwards. 
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Selecting the curve at point , gives a forward direction of 

downwards. 

 

 The blue asterisk (*) indicates the start point of the composite 

curve. 

 The blue arrow indicates the current end point of the composite 
curve.  

 To extend or change your composite curve either click on the 
next curve, or use the play buttons. 

 

When you have created the required composite curve, click  

or  to accept or cancel the curve creation. 

 The red curve indicates the current extents of the composite 
curve. 

 The pink curve indicates the direction PowerMILL follows if you 

click , or . You can also select this direction by clicking the 

pink curve. 

 The yellow curve indicates an alternative direction. To select this 
direction, click the yellow curve. 
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Selecting surfaces to create a composite curve 

You can create a composite curve using surface edges. You don't 

need curves to create a composite curve. 

With the Create Composite Curve mode toolbar displayed, where you 

select the surface affects: 

 the default direction of the composite curve. 

 the surface used to create that section of the composite curve. 

The forward direction is towards the surface corner closest to the 

selection point. Selecting a surface at point  creates the start 

point at the bottom right corner of the fillet surface ( ) and a 

current-curve-end at the bottom left corner of that fillet ( ). The 

curve used to create the composite curve is the surface edge of the 

fillet. 

 

It is easier to see if you undraw the shaded model: 
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If you select the surface around , the composite curve looks the 

same, but the curve used to create the composite curve is the 

surface edge of the vertical face. 

 

If you select the surface around , PowerMILL selects the surface it 

considers best. It does this by inspecting the p-curves of the 

underlying surfaces, and then selects the surface that is least likely 
to produce a 'faceted' curve. For instance, the edge of a cylinder 

produces a much better quality curve than a circle trimmed out of a 
plane. For example, if you select a boss or pocket in the 
powerdrill.dgk model, PowerMILL does not pick the trimmed plane. 

 The blue asterisk (*) indicates the start point of the composite 

curve. 

 The blue arrow indicates the current end point of the composite 

curve.  

 To extend or change your composite curve either click on the 

next curve, or use the play buttons. 

 

When you have created the required composite curve, click  

or  to accept or cancel the curve creation. 

 The red curve indicates the current extents of the composite 
curve. 

 The pink curve indicates the direction PowerMILL follows if you 

click , or . You can also select this direction by clicking the 

pink curve. 
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 The yellow curve and surface markers indicate alternative 

directions and alternative surfaces that PowerMILL uses to create 
the next section of the composite curve. To select a yellow 

option, click on the appropriate yellow curve or surface marker. 

 The grey arrow and surface indicate a possible, though unlikely, 

solution. Clicking it enables you to create a composite curve 
which has a start point at the bottom right corner of the fillet 

surface and goes along to the bottom left corner of the fillet and 
then returns to the start point by following the vertical surface 

edge. 

 
 

Composite Curve Direction toolbar 

Hovering over Direction  on the Create Composite Curve toolbar 

displays the Direction toolbar. Use the toolbar to determine the 

default direction at a branch point. 
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Clicking  Straight gives: 

 

 Pink indicates the direction that automatic sketching follows. 

Yellow indicates an alternative. 

Clicking  Left gives: 
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Clicking  Right gives: 

 

Clicking  Stop at discontinuity gives: 

 

This is the same as Straight  provided the angle at the branch 
point is less than the discontinuity angle specified on the Composite 

curve creator page of the Options dialog. However, it stops if the 

angle at the branch point is greater than the discontinuity angle 

specified (see page 31). 
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Clicking on the pink curve gives: 

 

In this case, the composite curve extends as far as point . 

Because the angle at the branch point is greater than the 
discontinuity angle, the composite curve creator extends the curve 

from the other end (point ). 
 

Composite Curve Jump Confirmation dialog 

When creating a composite curve, PowerMILL stops when it reaches 
a gap in the geometry. Click on the curve you want to join. 

 

Clicking on the orange curve displays the Composite Curve Jump 

Confirmation dialog.  

 

Use tangents to create the curve — When deselected, joins the curves 

with a straight line. When selected, joins the curves with a 

tangential curve. 
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Use tangents to create the curve deselected: 

 

Use tangents to create the curve selected: 

 

Next start tangent — Click to cycle through the various tangent 

options. 

Next end tangent — Click to cycle through the various tangent 

options. 

Yes — Click to accept the join and return to the Create Composite 

Curve toolbar (see page 12). 

No — Click to reject the join and return to the Create Composite 

Curve toolbar (see page 12). 

For more information, see Creating a composite curve from 'gappy' 
wireframe geometry (see page 24). 

If you are creating a composite curve by selecting surfaces rather 
than existing curves, and you want to bridge a gap, the Composite 

Curve Jump Confirmation dialog has an extra field. 
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Use tangents to create the curve deselected: 

 

 — When displayed, the composite curve remains an embedded 

curve. Hover over  to display more information. 

Use tangents to create the curve selected: 

 

 — When displayed, the composite curve is no longer an 

embedded curve. Hover over  to display more information . 

 If you create a composite curve by selecting surfaces or 

curves extracted from a surface, the resulting composite 

curve is an embedded pattern. 
 

Creating a composite curve from surface geometry 

This example shows how to create a composite curve from surface 

geometry. The result is a composite curve which is also an 
embedded pattern. 

This uses the 5axis_with_holes.dgk model in the Examples folder. 

1 Click  on the Pattern toolbar to create a new pattern. 

2 Click  on the Pattern toolbar. This displays the Curve Editor 

mode toolbar. 

3 Click  on the Curve Creation toolbar. 
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This displays the Create Composite Curve mode toolbar. 

 

4 Click  on the Direction toolbar. 

 

5 Click on the surface near . 

 

This selects the right edge of the surface. 

 Red indicates the selected surface curve. 

 Pink indicates the surface that automatic sketching follows. 

 Yellow indicates an alternative surface. 

 Grey indicates an alternative surface for the current curve. 

This is an option you are unlikely to use because it returns to 
the start point, but along the other surface. For more 

information, see Selecting curves to create a composite curve 
(see page 8). 
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6 Click  on the Create Composite Curve mode toolbar to create 

the automatic path. 

 

 Use the Esc key or click  (next to the progress indicator) 

if you want to stop the composite curve creation. 

7 Click  on the Create Composite Curve mode toolbar. 

8 Click  on the Curve editor mode toolbar. This creates an 

embedded pattern which follows the surface edges. 
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Automatic creation of a composite curve 

This example shows how to create a composite curve automatically 

by clicking a surface edge. 

It uses the 5axis_with_holes.dgk model in the Examples folder. 

1 Click  on the Pattern toolbar to create a new pattern. 

2 Click  on the Pattern toolbar. This displays the Curve Editor 

mode toolbar. 

3 Use the Alt key while selecting the surface edge near . 
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PowerMILL creates a composite curve using the default options. 

The resulting curve is highlighted. 

 

 

 Use the Esc key or click  (next to the progress indicator) 

if you want to stop the composite curve creation. 

4 Click  on the Curve editor mode toolbar. This creates an 

embedded pattern of the resulting curve. 
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Creating a composite curve from wireframe geometry 

This example shows how to create a composite curve from 

wireframe geometry.  

This uses an edited boundary generated from the 
5axis_with_holes.dgk model in the Examples folder. 

1 Double-click on the curve, near point , to raise the Curve Editor 

mode toolbar. 

 

2 Click  on the Curve Creation toolbar. 

 

This displays the Create Composite Curve mode toolbar. 
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3 Click the curve near point . 

 

 Red indicates the selected curve. 

 Pink indicates the curve that automatic sketching follows. 

 Yellow indicates an alternative route. 

4 Click the yellow curve. 
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5 Click the yellow curve. 

 

6 Click  on the Create Composite Curve mode toolbar. 

7 Click  on the Curve editor mode toolbar.  

 If, before step 3, you selected a Direction of , you can click 

 on the Create Composite Curve mode toolbar to create the 

automatic path. 
 

Creating a composite curve from 'gappy' wireframe 
geometry 

When creating a composite curve you have the ability to 'jump' 

gaps in the geometry. For example: 

1 Starting with a curve with a gap between neighbouring 

segments. 
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2 When creating a composite curve, PowerMILL automatically stops 

when it reaches the gap. 

 

3 Click the end of the orange curve, around . This displays the 
Composite Curve Jump Confirmation dialog.  

 

Deselecting the Use tangents to create the curve option joins the 

curve with a straight line. 
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Selecting the Use tangents to create the curve option joins the 

curves with a tangential curve. 

 

4 Click Yes on the Composite Curve Jump Confirmation dialog. 

5 Click  on the Create Composite Curve mode toolbar. 

6 Click  on the Curve editor mode toolbar.  

 You don't have to select the end of a curve you can select any 

point along it. For example, clicking around  in step 2 gives: 
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Creating a composite curve using marker points 

This example shows how to create a composite curve limited by 

marker points. You can have up to two marker points on any 

composite curve. 

This uses an edited boundary generated from the 
5axis_with_holes.dgk model in the Examples folder. 

1 Double-click on the curve, near point , to raise the Curve Editor 

mode toolbar. 

 

2 Click  on the Curve Creation toolbar. 

 

This displays the Create Composite Curve mode toolbar. 

 

3 Click the first Marker Point  button. 
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4 Click the curve near point . This places a red circle at the 

selection point. 

 

 To remove the marker point, click the first Marker Point  

button and then click the marker. 

 If the circle is blue, you have selected the second Marker 

Point button, not the first. 

5 Click the second Marker Point  button. 

6 Click the curve near point . This places a blue circle at the 

selection point. 

7 Click the curve near point . 
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8 Click the yellow curve. The composite curve creator goes as far 

as the first marker point, . It then reverses and continues to 

the next branch point, . 

 

9 Click the pink curve. 
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10 Click the yellow curve. The composite curve creator goes as far 

as the second marker point and stops. 

 

 PowerMILL ignores the marker point if you choose a route 

that doesn't meet the marker point. 

 

  The first marker point shows the start and end point of the 

closed composite curve. 

  The second marker point, which is ignored. 

11 Click  on the Create Composite Curve mode toolbar. 

12 Click  on the Curve editor mode toolbar.  
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Composite curve creator options 

The Create Composite Curve mode toolbar has various default 

options which you can specify on the Composite curve creator page 

of the Options dialog. This is available from Tools > Options > Curve 

Editor > Composite curve creator menu. 

 

Search both ways — When selected, the Composite Curve Creator 

searches both ends of the curve to find adjacent segments. When 
deselected, the composite curve creator searches only the current 

curve to find adjacent segments. 

Keep original curves — When selected, keeps the individual curves 

used to create the composite curve as well as the composite curve. 

This prevents the removal of the original curves from the 
pattern/boundary. 

Follow edges only — When selected, follows surface edges. When 

deselected, and the wireframe is displayed, enables you to select 
internal constant parameter lines within a surface as well as the 

surface edges. This can be useful for generating the drive curve for 
flowline machining. 
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Starting with this model: 

 

If you select the surface around . 
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With Follow edges only selected: 

 

You can select surface edges ( ), but not surface internals. 

With Follow edges only deselected, and the wireframe displayed: 

 

You can select surface edges or surface internals ( ). 
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With Follow edges only deselected, you can create curves such as: 

  

Gap jumping multiplier — Enter a value to determine if PowerMILL 

can automatically jump the gap. This value is multiplied by the 
Closure tolerance to give an actual value. If the gap is larger than 

this value the Composite Curve Jump Confirmation dialog is 

displayed. If the gap is smaller than this value PowerMILL works as 

if there is no gap (see page 15). 

Maximum discontinuity angle — Enter the maximum angle, at a 

branch point, which is still considered as straight. 

Changing the Maximum discontinuity angle effects the options 

presented when you select a direction of . 

If you enter a small Maximum discontinuity angle the options are 

almost straight, in this case, . 
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If you increase the Maximum discontinuity angle the number of 

options increase, in this case,  and . 

 

Further increasing the Maximum discontinuity angle adds more 

options, in this case, , , and . 

 

Direction at branch point — Select the default direction displayed on 

the Create Composite Curve mode toolbar (see page 12). 
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Improved hole creation and editing 
There are several enhancements to hole creation and editing: 

 There is an improved process for hole creation as it is 

significantly different to the creation of other features. There is 
now a separate dialog for hole creation so the Feature dialog no 

longer contains the hole specific options (see page 36). 

 There is a new dialog to control hole editing, and hole 

intersections (see page 44). 

 There are several changes to the Feature Set menu and 

individual feature set menu (see page 60). 

 There is a new page on the Options dialog to specify the hole 

creation options (see page 63). 
 

Create Holes dialog 

Use the Create Holes dialog to create holes.  

  

Display the Create Holes dialog by either: 

 selecting Create Holes on the Feature Sets menu; or 

 selecting Create Holes on the individual feature sets menu. 

Name root — Enter a name for the hole. Each hole has the root 

name followed by a number. If there is no root name then the hole 

just has a number. 
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Create from — Select how to recognise holes. 

Points — Select to create holes from points in the pattern. These 

points define the centre of the hole. 

Circles — Select to create holes from circles in the model. 

Model — Select to create holes from holes in the model. 

Pairs — Select to create holes from pairs of circles in the model. 

Curves — Select to create holes from any curve in the model that 

can flatten into a circle in the given workplane. 

Lines — Select to create holes from lines in the pattern. These 

lines define the top, bottom, and axis of a hole. 

Plunges — Select to create holes from the plunge moves of the 

active toolpath. 

Normals — Select to create holes from contact-normal moves of 

the active toolpath. 

 If you select a Create from of Model, the dialog options are 

different. For more information see Create Hole > From Model 

dialog (see page 40). 

Define top by — These options determine the height of the top of the 

hole. 

Absolute — Select to define the top as an absolute Z height. 

Height from Bottom — Select to define the top as a distance from 

the bottom of the feature/hole. 

Maximum Curve Z — Select to define the top as the maximum Z 

height of the selected curve, location . All features use a curve 

(bits of model or pattern) as the input data. These curves have a 
minimum and a maximum Z value, which you can use for feature 

definition. This is useful for hole definition where you have a set 
of Z positions that represent the top or bottom of the hole.  

Minimum Curve Z — Select to define the top as the minimum Z 

height of the selected curve, location . 

 

 

 

    Maximum Z 

    Minimum Z 
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Curve centre — Select to define the top as halfway between the 

top and bottom of the curve (midway between  and ). 

Top of Block — Select to define the top as the height of the top of 

the block. 

Line Start — Select to define the top as the start of the line.  

 This option is available only if you selecte a Use of Lines. 

 — Enter the height of the top of the feature. 

Define bottom by — These options determine the height of the 

bottom of the hole. 

Absolute — Select to define the bottom as an absolute Z height. 

Depth from Top — Select to define the bottom as a distance from 

the top of the feature/hole. 

Maximum Curve Z — Select to define the bottom as the maximum 

Z height of the selected curve, location . All features use a 

curve (bits of model or pattern) as the input data. These curves 

have a minimum and a maximum Z value, which you can use for 
feature definition. This is useful for hole definition where you 

have a set of Z positions that represent the top or bottom of the 
hole.  

Minimum Curve Z — Select to define the bottom as the minimum 

Z height of the selected curve, location . 

 

 

    Maximum Z 

    Minimum Z 

 

Curve centre — Select to define the bottom as half way between 

the top and bottom of the curve. Midway between  and . 

Bottom of Block — Select to define the bottom as the height of 

the bottom of the block. 

Line End — Select to define the bottom as the end of the line. 

 This option is available only if you selecte a Use of Lines. 

 — Enter the height of the bottom of the feature. 

Upper diameter — Enter the upper diameter of the hole.  

 The Upper diameter is the same as the Lower diameter unless 

the hole has a Draft angle. 

Draft angle — Enter the draft angle of the hole. 
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Draft angle of 0: 

 

Draft angle of 10: 

 

  

 

 

 

Group holes by axis — When selected, sorts the holes into feature 

sets by workplane. In this case, your machine tool must have3+2-

axis drilling capability. When deselected, places all the holes in one 
feature set. In this case, your machine tool must have multi-axis 

drilling capability. 

This example uses the RetainerPlate.dgk model. It has an active 

workplane, and the whole model is selected: 
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Deselecting Group holes by axis gives: 

 

Selecting Group holes by axis gives: 

 

Edit after creation — When selected, clicking Apply creates the holes 

and then displays the Edit Hole dialog (see page 44). 
 

Create Holes from model dialog 

Use the Create Holes dialog with a Create from of Model to create 

holes from holes in the model. 
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To display this dialog, select Create Holes on the Feature Sets menu. 

Name root — Enter a name for the hole. Each hole has the root 

name followed by a number. If there is no root name the hole just 

has a number. 

Create from — Select how to recognise holes. 

Points — Select to create holes from points in the pattern. These 

points define the centre of the hole. 

Circles — Select to create holes from circles in the model. 

Model — Select to create holes from holes in the model. 

Pairs — Select to create holes from pairs of circles in the model. 

Curves — Select to create holes from any curve in the model that 

can flatten into a circle in the given workplane. 

Lines — Select to create holes from lines in the pattern. These 

lines define the top, bottom, and axis of a hole. 

Plunges — Select to create holes from the plunge moves of the 

active toolpath. 

Normals — Select to create holes from contact-normal moves of 

the active toolpath. 

Tolerance — Enter the tolerance used to create holes. 

Create compound holes — When selected, creates one compound 

hole containing several components. When deselected, creates 

several individual holes (superimposed on each other). 

A compound hole is one hole containing several components; in this 
case, a hole named 1 with components 0 and 1. 

If you create them  as individual holes, there are two holes named 1 
and 2. 

 

For more information, see Compound Holes. 

Use active workplane only — Select to create only the holes that 

have a Z axis that aligns with the Z axis of the active workplane. 
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This example uses the RetainerPlate.dgk model. It has an active 

workplane, and the whole model is selected: 

 

 

Selecting the Use active workplane only gives: 

 

Deselecting Use active workplane only gives: 

 

 

Find holes in both directions — When Group by hole axis is selected, 

places holes from both directions into a single multi-axis feature 
set. When Group by hole axis is deselected, splits the holes into two 

feature sets (one for up and one for down). 

Find holes going up — Places the holes going up into a single feature 

set.  

Find holes going down — Places holes going down into a single 

feature set.  
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Group holes by axis — When selected, sorts the holes into feature 

sets by workplane. In this case, your machine tool must have3+2-
axis drilling capability. When deselected, places all the holes in one 

feature set. In this case, your machine tool must have multi-axis 
drilling capability. 

This example uses the RetainerPlate.dgk model. It has an active 

workplane, and the whole model is selected: 

 

Deselecting Group holes by axis gives: 

 

Selecting Group holes by axis gives: 

 

Try to recognise partial holes — Select to enable the creation of holes 

from a model that has poorly, or incompletely defined, holes. For 

example, creating a hole from a pair of arcs. 

 Use this option as a last resort because it may find many 

unwanted (or unexpected) holes. 
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Ignore holes with no open ends — When selected, creates holes which 

have at least one open end, and ignores holes with two closed ends. 

Edit after creation — When selected, clicking Apply creates the holes 

and then displays the Edit Hole dialog (see page 44). 
 

Edit Holes dialog 

Use the Edit Holes dialog to edit the geometry, properties or hole 

intersections.  

 

Display the Edit Holes dialog by either: 

 selecting Edit Holes on the Feature Sets menu; or 

 selecting the Edit after creation option on the Create Hole dialog 

(see page 36). 

There are three tabs associated with this dialog: 

 Geometry — Select to edit the size of the hole, or hole 

component (see page 45). 

 Properties — Select to edit the hole metadata, for example name 

and colour (see page 57). 

 Intersection — Select to delete hole intersections (see page 58). 
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Edit Holes > Geometry 

The Geometry tab on the Edit Hole dialog edits a component of a 

hole (see page 44). 

 

 Move Up — Click to move the selected component up one 

position. 

 Add component — Click to add a component. The new 

component is the same size as the selected component. You can 

then edit its size in the lower half of the dialog.  

 Delete Selected — Click to delete the selected component. 

 Move Down — Click to move the selected component down one 

position. 

The graphic displays the hole you are editing. For compound holes, 

the currently editable component is cross-hatched blue. To edit a 
different component, select it in the graphics pane. 

 You can use the keyboard arrows (  ) to select the relevant 
component which can be useful when selecting small 

components. 
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 If you select multiple holes that are the same size and have 

the same components, you can edit them all together. If you 
select multiple holes that differ, the differing components are 

grey. However, you can still move them and edit the values in 
the lower part of the dialog. 

 

Where the selected holes have the same value, the value is 
displayed (for example Draft angle). 

Where the selected holes have differing values, the field is empty 
(for example Upper diameter). 

Upper diameter — Enter the diameter at the top of the current 

(cross-hatched component. This must be greater than or equal to 
the Lower Diameter. 

Depth — Enter the vertical height of the component. 

Lower diameter — Enter the diameter at the bottom of the current 

(cross-hatched) component. This must be less than or equal to the 
Upper Diameter. 

Draft angle — Enter the draft angle of the hole. 
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Draft angle of 0: 

 

Draft angle of 10: 

 

  
 

Fillet radius — Enter the radius.  

A Fillet radius of 0 gives a standard hole component with no fillet: 
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Entering a Fillet radius gives: 

 

 The minimum fillet radius has a diameter equal to the length 

( ) of the hole component. The length of the component is 
the same as the Depth for a hole with no draft angle. 

 

 The diameter of the fillet must be at least as large as the 
length of the component. 
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Fillet type — Select either a Concave or Convex fillet. 

Fillet type of Concave: 

 

Fillet type of Convex: 
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Hole position — Enter the x, y, z coordinates of the centre of the 

hole. 

 — Click to display the Position dialog. Use the dialog to manually 

enter coordinates and locate items in the graphics window. 

Hole axis — Enter the orientation of the Z axis of the hole. 

 — Click to display the Direction dialog, which enables you to edit 

the direction of an item. 

 — When displayed, hover over  to see more information. 

 If you edit any of these fields you must click Apply for them to 

take effect. 

For an example on using this dialog, see Editing automatically 
identified holes (see page 50). 

 

Editing automatically identified holes 

This example shows how to edit holes generated automatically from 
the Create Holes option. It uses the RetainerPlate.dgk model in the 

Examples folder. 

 

 

1 Select part of the model, including some of the holes. 

2 From the Feature Sets menu, select Create Holes. 

This displays the Create Holes dialog. 



 

PowerMILL 2014 R2 What's New Toolpath preparation • 51  

  

3 On the Create Holes dialog: 

a Select a Create from of Model. 

b Select Create compound holes. 

c Deselect Group holes by axis. 

d Select Edit after creation. 

e Click Apply. 

PowerMILL recognises the selected holes. 

 

  Standard holes with the Z axis of the hole aligned with the 

workplane Z axis. 
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  Compound holes with the Z axis of the hole aligned with the 

workplane Z axis. 

  Standard holes with the Z axis of the hole not aligned with 

the workplane Z axis. 

4 Select the hole you want to edit. 

 

 You can also edit holes graphically. 

5 On the Edit Holes dialog, edit the required fields, in this case, the 

Upper Diameter, and X and Y coordinates. 
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 Altering the Upper Diameter automatically updates the Lower 

Diameter. 

 If you edit a compound hole, select the relevant component in 
the graphical area of the dialog (the selected component is 

cross-hatched), and then edit the appropriate values. 

 

  the selected component. 
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 When you select a hole where the Z axis of the hole is not 
aligned with the workplane Z axis, the Hole position 

coordinates are shown relative to the active workplane rather 

than the workplane of the hole. In this case  is added to the 

dialog. Hovering over  displays more information. 
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Creating and editing compound holes 

This example shows how to edit holes generated automatically from 
the Create Holes option. It uses the RetainerPlate.dgk model in the 

Examples folder. 

 

1 Select part of the model, including some of the holes. 

2 From the Feature Sets menu, select Create Holes. 

This displays the Create Holes dialog. 

  

3 On the Create Holes dialog: 

a Select a Create from of Model. 

b Select Create compound holes. 

c Deselect Group holes by axis. 
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d Select Edit after creation. 

e Click Apply. 

PowerMILL recognises the selected holes. 

4 Select the hole you want to edit. 

 

5 On the Edit Holes dialog: 

 

a Click  to add a second component. 

b Select the lower component. 

c Enter an Upper diameter of 50. 

d Enter a Depth of 100. 
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You can use this dialog to build up a more complex compound hole, 

such as: 

 
 

Edit Holes > Properties 

Use the Properties tab on the Edit Hole dialog to edit the hole 

metadata, for example, name and colour (see page 44). 
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Name — Enter the name of the active hole. 

Description — Enter a description. You can use this description as a 

selection criteria when selecting holes or for drilling methods (you 

can give a set of holes a description then state that the method only 

applies to holes with that description). For more information, see 
Select Features. 

Hole Type — Enter a description. You can use this description as a 

selection criteria when selecting holes or for drilling methods (you 

can give a set of holes a description then state that the method only 
applies to holes with that description). For more information, see 

Select Features. 

Edit Colour — Click to display the standard Windows Color dialog. 

Select the relevant colour and click OK to close the dialog. Use to 

change the colour of the selected feature or hole.  
 

Edit Holes > Intersection 

The Intersections tab on the Edit Holes dialog enables you to delete 

hole intersections (see page 44). 
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 To use this you must first identify the hole intersections (from 
the Feature Sets context menu, select Find Hole Intersections). 

The left side of the dialog displays a list of the intersections of the 

selected hole. 

 Delete — Click to delete the intersections selected in the left side 

of the dialog. 

For more information, see Reducing feed rates at hole intersections 

or Deleting a hole intersection. 
 

Enhancements to the Feature Set menu 

There are several changes to the Feature Set menu. 

 

The Feature Set Editor option is now on the Edit menu. 

There are several new options: 

Create Holes this displays the settings used to create the hole. Hole 

creation now uses a different dialog to feature creation (see page 
36). This combines the Create Feature Sets option (with a Type of 
Hole) and the Recognise Holes in Model option. 

Find Hole Intersections and Delete All Hole Intersections are lower in 

the menu than in previous versions. 

Select Hole replaces Select Feature. It is now called Select Hole 

because you can use it only to select holes and not other features. 

The Preferences option is no longer available because these options 

are now available on the Create Feature Set or Create Holes options. 
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Enhancements to the individual feature set menu 

There are several changes to the individual feature set menu. 

 

 

The Feature Set Editor option is now on the Edit menu. 

There are several new options: 

Select Hole was called Select Feature. It is now called Select Hole 

because you can use it only to select holes and not other features. 

Create Features replaces the Settings option in previous versions. 

This displays the settings used to create the feature. 

Create Holes displays the settings used to create the hole (see page 

36). 

Separate Compound Holes separates all compound holes into single 

holes. This is on the Edit menu. 
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In this example there are two standard holes and three compound 

holes. The compound holes are orange. 

 

Looking at the feature set you can see the holes: 

 

Selecting Separate Compound Holes converts the compound holes to 

their individual hole components. 

 

 If you select one (or more) compound holes then PowerMILL 

separates only the selected holes. 
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Combine Holes combines single holes into compound holes. This is 

on the Edit menu. 

In this example there are eight holes. Starting with these holes. 

 

Looking at the feature set, you can see the holes: 

 

Selecting Combine Holes converts the individual hole components, 

which share a Z axis, to a compound hole. 
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Hole creation options 

There is a new page on the Options dialog of Hole Creation > Options. 

The Hole Creation Options determine the default options used to 

create a hole. 

 

Use block to find direction — Select to use the block to determine the 

direction of holes. When selected, holes point towards the block 

centre. 

Use surfaces to find direction — Select to use the surfaces to 

determine the direction of holes.  

Add components in gaps — Select to add extra hole components to 

fill in vertical gaps between hole components in compound holes. 

Maximum depth — Enter the maximum depth of a hole component 

you can add when selecting Add components in gaps. No additional 

components are added if a compound hole contains a gap larger 

than this value. 

Ignore outside surfaces — Select to use the inner surface to create a 

hole, this is useful where you have a hole inside a boss.When 

deselected, PowerMILL creates two holes: one for the inside and 
one for the outside, this is useful for tapped holes where both 

surfaces are modelled.  

 This option is disabled when Use surfaces to find direction is 

deselected. 
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Boundary editing history 
You can now see a history of your boundary edits. This is similar to 
the history of your toolpath edits. 

Use the Boundary Editing History dialog to show a history of all the 

edits on a boundary. It also enables you to edit some of them. 

 

The Boundary Editing History dialog is available from the individual 

boundary Edit > Boundary Editing History menu or by clicking  on 
the Boundary toolbar. 

Boundary — Select the boundary to review and re-edit the 

boundary's previous edits. 

Edits — The pane displays a list of all the edits performed on the 

boundary. The most recent edit is at the top of the list and the 
original boundary is at the bottom of the list. The right side of the 

dialog displays information on the selected edit. 
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In this case, the edit moved the boundary by 20 mm in X and you 

can edit these values. 

 If you make more than one transform before accepting the 

result, PowerMILL shows a complex transform rather than the 
separate individual transforms. 

For example: 

1 From the individual boundary menu, select Edit > Transform. This 

displays the Boundary Transform mode toolbar. 

 

2 Click  on the Boundary Transform mode toolbar. This displays 
the Move toolbar. 

 

3 On the Move toolbar: 

a Enter the coordinates 20 0 0 in the  field on the status 

toolbar. 

b Click  to close the Move toolbar. 

4 Click  on the Boundary Transform mode toolbar. This displays 
the Rotate toolbar. 

 

5 On the Rotate toolbar: 

a Enter an Angle of 15. 

b Click  to close the Move toolbar. 
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6 Click  on the Boundary Transform mode toolbar to accept the 

two transforms. 

7 From the individual boundary menu, select Edit > Boundary 

Editing History. This displays the two transforms as one complex 

transform. 

 

In this case, you can see the matrix that combines the move and 
rotation but you cannot edit these values. You can delete this 

transformation by clicking . 

 Delete — Click to delete the selected edit. 

 — When displayed, the boundary contains selective edits. Hover 

over  to display more information. 

 If your boundary edits contain selective edits you can modify 
the edits, but clicking on the Calculate button only applies the 

edits up to, but not including, the selective edit.  



 

PowerMILL 2014 R2 What's New Toolpath preparation • 67  

A selective edit is an edit that requires you to select a curve 
segment or a point. For example, Delete Selected Components. 

 

  The selective edit. 

   Indicates that if you edit any values, you can re-calculate 

your boundary, but the history is not fully re-applied. 

Notes — Type any specific notes to help you understand the edit. 

If you select the boundary, rather than an edit, the right side of the 
dialog displays the Boundary page. 

 

Name — Displays the name of the boundary. 

 — Click to display the Boundary dialog. This is the same dialog 

that is displayed when you create or edit a boundary. 

Calculate — Click to recalculate the boundary based on edits you 

make to this dialog. 
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Improvements to specifying the tool 
stock material 

In previous versions of PowerMILL you could enter a new stock 

material of a tool, but you were unable to see the existing stock 
materials. So, it wasn't easy to use an existing material as you had 

to match the spelling and capitalisation correctly. Now you can 
select an existing material from a list, or create a new material. 

Use the Tool Stock Material dialog to specify or change the stock 

material of tools. 

 

The Tool Stock Material dialog is available on the Tools context 

menu, or on the individual tool context menu. 

Tool — Use these options to identify the tools whose stock material 

you want to change. 

Specified tool — Select to enter a stock material for the tool selected 

in the list. 

 — Select the required tool from the list. 

Selected tools — Select to enter a stock material for all tools 

selected in the explorer. 

All tools — Select to enter a stock material for all tools in the 

project. 

With material — Select to enter a stock material for all tools which 

currently have the material specified in the list. 
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 — Select the required material from the list. If no 

material is selected, the material is applied to all tools which don't 

have a material. 

Material — Use these options to specify the required stock material. 

 — Select a stock material from the list. If there are 

no materials listed, or the material you require isn't listed then you 

must create a new material using . 

 New Stock Material — Select to create a new stock material. This 

displays the New Stock Material Name dialog. 

To create a new stock material: 

1 Click  to displays the New Stock Material Name dialog: 

 

2 Enter a name for the new stock material  

 Spaces are not allowed in stock material names. 

So, for example, Mild Steel is not a valid name because 

there is a space in the name; but the names Mild_Steel or 

MildSteel are valid. 

3 Click . 
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Drilling enhancements 
When drilling compound holes, you can now choose which hole 
components you want to drill (see page 71). 

When creating a drilling method you can now: 

 

 Add a toolpath: select an existing drilling toolpath, then click  

to add it to the drilling method.  

 Add a note: click Note  to display the Method Notes dialog. Use 

the dialog to enter a note about the drilling method. The notes 

appear at the top of the method xml file. 

 
 

Toolpath generation 
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Drilling enhancements 

When drilling compound holes, you can now choose which hole 

components you want to drill. 

On the drilling strategy dialogs you can now select the Bottom 

component. If you select a Define top by of Component top you can 

also specify a Top component. 

 

For example, with this compound hole: 

 

Selecting a Top component of 2 and a Bottom component of 3 or Last 

produces a toolpath on the bottom two components. 
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Dynamic machine control mode 
The new Dynamic machine control mode enables you to adjust the 

configuration and tool axis of a 3+2 axis machine tool, so you can 

quickly and easily improve the machine tool's access to the 

workpiece. 

The mode includes: 

 Interactive grab-handles let you drag the machine tool into new 
positions (see page 74). 

 The Dynamic machine control mode toolbar features a range of 
buttons that compliment the use of the grab-handles. The Swap 

machine tool configuration button  is very useful for orientating 

a machine tool with an asymmetrical head (see page 76). 

 The Dynamic machine control mode dialog lets you manually 

specify the machine tool position and tool axis, instead of using 
the interactive grab-handles. The dialog also enables you to 

specify the increment value for rotary axes (see page 78). 

 

  

In this graphic, access to the workpiece is improved by rotating the 
grab-handle to adjust the machine tool's configuration and tool axis. 

Advanced simulation 
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Entering the Dynamic machine control mode 

 To use the Dynamic machine control mode, you must have the 

PowerMILL Advanced Simulation licence (POWERMILL–
ADVSIM). 

You can enter the mode at any time. 

 The mode is only available for the following tools: ball nosed, 

tip radiused, end mill, tapered spherical or tapered tip. 

Activating a mode disables most of PowerMILL's functionality 
until you exit from the mode. For more information, see Mode 

toolbars. 

To enter the mode, click  on the Tool toolbar. Entering the mode 

displays grab-handles around the tool  and the Dynamic machine 

control mode toolbar. 
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Repositioning the machine tool interactively 

You can improve the machine tool's access to the workpiece by 

repositioning the machine tool with the new interactive features. 

 You may find it useful to use the interactive features to 
reposition the machine tool approximately and then use the 
Dynamic machine control mode dialog to position the machine 

tool more accurately (see page 78). 

The interactive features include: 

Jump to a point 

Double-clicking on the model makes the machine tool jump to the 
selected point. 

 

Grab-handles 

Each grab-handle is associated with an axis. By dragging a grab-
handle, you move the machine tool within the associated axis. The 

circular grab-handles rotate the tool axis, and the linear grab-

handles move the tool along a single axis. There are two sets of 
grab-handles that you can toggle between so you can achieve the 

best tool configuration and tool axis:  

Clicking  displays the grab-handles aligned to the active 

workplane . 

Clicking  displays the grab-handles aligned to the axes of the 

machine tool . 
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When you hover the cursor over a drag-handle, the drag-handle is 

highlighted. You can then drag the machine tool into a new position. 

 

Dragging the tool 

When you hover the cursor over the tool, the cursor changes to . 
This enables you to drag the machine tool free-hand across the 

model. 

 

 Dragging the tool free-hand (or 'scanning' the model with the 
machine tool) is a useful technique for quickly seeing if the 

current tool axis is appropriate for machining the surface of 
interest. 
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Using the Dynamic machine control mode toolbar 

The buttons on the Dynamic machine control mode toolbar 

compliment the use of the grab-handles. For more information 

about using the grab-handles, see Repositioning the machine tool 
interactively (see page 74). 

 

 Select tool — Click to select the tool you want to simulate. 

This enables you to simulate an alternative tool to the one used by 
the current toolpath. If the cutting geometry of the alternative tool 

is the same as the original tool, you can click Update toolpath  to 

update the toolpath so it now uses the alternative tool. 

 Lock tool axis — Click to lock the tool axis. This limits the 

machine tool movement to the X, Y, and Z axes, which is useful if 
you want to preserve the tool axis while changing the configuration 

of the machine tool. 

 Rotate around current workplane — Click to display the grab-

handles aligned to the active workplane (see page 74). 

 Use machine tool graphics — Click to display the grab-handles 

aligned to the axes of the machine tool (see page 74). 

 Use tool positioning graphics — Click so you can simultaneously 

move the machine tool in the X, Y, and Z axes of the active 

workplane. 

 Advanced settings — Click to display the Dynamic machine control 

mode dialog. The dialog enables you to specify the tool orientation 

(position and axis), as well as increment values to restrict the 
movement of the tool's rotary axes (see page 78). 

 Machine Tool Position — Click to display the Machine Tool Position 
dialog. The Machine Tool Position dialog displays the position of each 

machine tool axis. You can use the dialog for reference purposes 
and to jog the machine tool's axes by using the dialog's interactive 

features (see page 87). 

 Swap machine tool configuration — Click so PowerMILL 

reorientates the machine tool but without changing the tool axis. 
This is especially useful for moving an asymmetrical machine head 

out of the way. 

 Align with view — Click to align the tool axis direction with the 

direction of your current view. 

Create workplane aligned with tool — Click to create a workplane 

aligned with the machine tool.  
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 Create workplane at tool tip — Click to create a workplane at the 

tool tip. 

 Choose the workplane that suits your preferred working 
method. 

 Update toolpath — Click to update the toolpath with the new 

machine tool position. 

 After updating the toolpath, you must check the toolpath 
for collisions using the Toolpath verification function. 

 The Update Toolpath function can be used only when you 

are using a tool with a spherical tool tip. To update a 
toolpath that uses a tool with a non-spherical tip, you have 

to enter the values of the new tool position in the toolpath's 
strategy dialog.  

 Undo — Click to revert to what it was before the last change. 

 Redo — Click to reinstate the edit you have just undone. 

 Nearest valid position — If you move the machine tool beyond its 

physical limits, you can click  so PowerMILL moves the tool to the 

nearest valid position. 

   PowerMILL displays one of these icons if there is an 

issue.The icon displayed depends on the severity of the issue. Hover 

the cursor over the icon for more information. 

 Accept changes — Click to accept changes and resume normal 

PowerMILL functions. 

 Close — Click to exit the mode without saving changes. 
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Using the Dynamic machine control mode dialog 

There are four tabs on the Dynamic machine control mode dialog: 

 Tool axis  

 Position  

 Machine tool  

 Axis restrictions  

To display the new dialog, click  on the Dynamic machine control 

mode toolbar (see page 76). 
 

Tool axis tab 

The Tool axis tab on the Dynamic machine control mode dialog 

displays the tool axis direction as vectors and apparent angles. The 

values update automatically when you use the grab-handles to 
adjust the tool axis. 

 

Tool name — The name of the tool. 

Axis direction — Specify the tool axis as vectors. 

Apparent angles — Specify the tool axis as apparent angles. 

 Direction — Click to display the Direction dialog. The dialog 

enables you to specify the tool axis instead of using the grab-

handles. 

 You may find it useful to use the grab-handles to specify the 
tool axis approximately and then use the Tool axis tab to 

specify the tool axis more accurately. 
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Position tab 

The Position tab on the Dynamic machine control mode dialog 

displays the tool position in X, Y, and Z (relative to the active 
workplane). The values update automatically when you use the 

grab-handles to adjust the tool position.  

 

Tool name — The name of the tool. 

Contact point — Displays the contact point between the tool and the 

model . 

Tool tip — Displays the position of the tool tip . 

Tool centre — Displays the position of the tool centre . 

 The Tool centre field is displayed only when you are 

simulating a tool with a spherical tip. 

 Anchor point — The indicates which point PowerMILL is currently 

using as the centre of rotation when you move the machine tool: 

Contact point — Used when the tool is in contact with the model. 

Tool tip — Used when the tool is not in contact with the model 

and the simulated tool has a non-spherical tip. 

Tool centre — Used when the tool is not in contact with the 

model and the simulated tool has a spherical tip. 

 Position — Click to display the Position dialog. The dialog 

enables you to define the position of tool by specifying the position 

of the tip or centre of the tool.  

 You may find it useful to use the grab-handles to define the 
tool position approximately and then use the Position tab to 

specify the tool position more accurately. 
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Machine tool tab 

The Machine tool tab on the Dynamic machine control mode dialog 

displays the position of each machine tool axis. The values update 
automatically when you use the grab-handles to adjust the position 

of the machine tool's axes. 

 

Tool name — The name of the tool. 

Machine axes — Specify the position of the machine tool's axes. 

 You may find it useful to use the grab-handles to reposition 

the machine tool's axes approximately and then use the 
Machine tool tab to specify the position of the axes more 

accurately. 
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Axis restrictions tab 

The Axis restrictions tab on the Dynamic machine control mode dialog 

enables you to enter the increment values of your actual machine 
tool's axes, so the axes of the virtual machine tool move accurately. 

 

Tool name — The name of the tool. 

Restrict axis — Select to restrict the movement of the axis by the 

specified increment value. 

Increment value — Specify the increment value. 

 If you adjust an axis without an increment restriction, it is 
possible that the axis position may not be achievable by your 

actual machine tool. 

If the current axis value is 83.34, for example, and you 

restrict the axis with an increment value of 1, when you 

adjust the axis, the axis value is rounded down to 83 and 

then increases 83 – 84 – 85 and not 83.34 – 84.34 – 85.34. 
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Using the Dynamic machine control example 

This example shows how to use the functions of the Dynamic 

machine control mode to prevent collisions between the machine 

tool and the workpiece. 

The example uses the DynamicMachineControl_Example project in the 

Examples folder. 

1 In the Toolpaths branch of the explorer, right-click the toolpath 
and select Simulate from Start. 

As the machine tool machines down the surfaces of the 

workpiece, the head and the A axis-component of the machine 
tool collide with the workpiece. 

   

2 On the Tool toolbar, click  to enter the Dynamic machine 

control mode. 

This displays the Dynamic machine control mode toolbar and the 

grab-handles around the tool. 

 

 

3 On the mode toolbar, click  to display the Machine Tool Position 

dialog. 
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The dialog displays the position of each machine tool axis. 

Displaying the dialog is useful because it enables you to see the 
movement of the axes and, in particular, if you move an axis 

beyond its limit. 

 

4 Specify the increment values of the rotary axes of the actual 
machine tool. This ensures that any adjustments you make to 

the virtual machine tool's axes can be achieved by the actual 
machine tool. 

a On the mode toolbar, click  to display the Dynamic machine 

control mode dialog, and then select the Axis restrictions tab. 

b For both A and B axes, select the Restrict axis option and 

specify an increment value of 2. 

5 Reconfigure the machine tool's position and tool axis. 

a On the mode toolbar, click  to display the grab-handles 

aligned to the axes of the machine tool. 

b Use the grab-handles to reconfigure the machine tool. 
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c Click  to swap the machine tool's configuration. PowerMILL 

improves the machine tool's clearance by adjusting the 

configuration of the machine tool (in particular by rotating the 
machine head by 180 degrees) but without altering the tool 

axis. 

d Double-click on various areas of the toolpath to make sure the 

new configuration and tool axis do not cause any new 
collisions. 

6 Click  to update the toolpath with the machine tool's new 

position and tool axis. 

7 The left side of the workpiece requires a similar toolpath. Repeat 

step five to achieve a suitable machine tool position and tool 
axis. 

 

8 Click  to create a workplane aligned with the tool. You can use 

this workplane when you create the toolpath for the area. 

9 Click  to accept the changes. 
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NC program updates 
There are several updates to NC program functions: 

 You can now multi-select NC programs in the explorer in the 

same way that you can multi-select other PowerMILL entities. In 
previous version you could select only one NC program at a time. 

 There is a new option which enables you to draw toolpaths in the 
Toolpaths branch of the explorer that are used in an NC program 

(see page 85). 

 You can now add toolpaths to an NC program multiple times (see 

page 86). 

 In the NC program dialog, you can now create a new fixture 
offset by entering its name in the Fixture offset list. 

 
 

 

Drawing toolpaths in an NC program 

The introduction of light bulbs  next to toolpaths in an NC program 
now enables you to choose which toolpaths in an NC program you 

want to draw. 

When you create an NC program, the toolpaths you add to it are 

drawn but the NC program isn't. Click the NC program's light bulb to 
draw the NC program and display the toolpaths. 

 

Toolpath output 
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Drawing a toolpath, which is in an undrawn NC program, 

automatically draws the NC program, so the toolpath is displayed. 

 

 In previous versions of PowerMILL, drawing an NC program 

displays all the toolpaths in the NC program and, in the 
Toolpaths branch, the lightbulbs next to the those toolpaths 

update to . 

In PowerMILL 2014R2, to display the toolpaths in the 
Toolpaths branch that are included in an NC program, use the 

new options on the individual NC program menu: 

Draw toolpaths — Click to draw all the toolpaths in the 

Toolpaths branch that are included in the NC program. 

Undraw toolpaths — Click to undraw all the toolpaths in the 

Toolpaths branch that are included in the NC program. 

 

Duplicating toolpaths in an NC program 

You can now place a toolpath into an NC program multiple times. In 
previous versions of PowerMILL this was not possible. 

PowerMILL 2014 R2 allows toolpath duplication by default. When 
you write the NC program, PowerMILL displays a message to tell 

you that the NC program contains duplicates of a toolpath. 

To disallow duplicate toolpaths, deselect the Tools menu > Options > 

NC Programs > Allow duplicate toolpaths option. 
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Positioning a machine tool 
The new Machine Tool Position dialog replaces the Machine 

Information dialog. The new dialog features a significantly 

redesigned user interface that improves the presentation of the 

machine-tool-position data and enables you to jog a machine tool 

more easily (see page 88). 

In previous versions of PowerMILL, the Machine Collisions tab 

displayed collision data. In PowerMILL 2014R2, collision data is 
displayed on the new Machine Tool Collisions dialog (see page 90). 

To display the new dialogs: 

 On the Machine Tool toolbar: 

 click  to display the new Machine Tool Position dialog. 

 click the new Collisions button  to display the Machine Tool 

Collisions dialog. 

 

 In the explorer, right-click the active machine tool and select the 
new Collisions and Position options. 

 
 

User interface 



 

88 • User interface PowerMILL 2014 R2 What's New  

The new Machine Tool Position dialog 

The new Machine Tool Position dialog includes the following 

features: 

 

 The axis address (A) and the icon indicates the axis and the axis 

type. 

 Indicates a linear axis. 

 Indicates a rotary axis 

 Drag the thumb  to jog the axis. The value -90 is the current 
position of the axis. The blue line and the values -112 and -58 

indicate the furthest points that the axis has been jogged to during 
the current simulation session. 

You can also jog an axis by: 

 clicking the the thumb and then using the mouse scroll-wheel 

or arrow keys  . 

 clicking on a point along the slider. 

 entering a value in the Position field (highlighted yellow). 
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 The Min and Max axis values are displayed at either end of the 
slider. The values displayed above the Min and Max values indicate 

the maximum range you can move the slider in one go. 

If the range of the slider is not large enough to jog the axis to its 
Min or Max limit in one go: 

 Drag the thumb to the end of the slider. PowerMILL displays 
the remaining range of the slider, so you can jog the axis to 
its Min or Max limit. 

 

 PowerMILL displays a warning if you enter an axis position (in 
the Position field) that is greater than the axis limit. 

 Reset attained axis positions — Click to clear the blue lines  

which indicate the range of movement of each axis. It is useful to 

click  before you jog or simulate the machine tool. 

 

 Home — Click to reset the position of the machine tool to its 

home position. 

 Collisions — Click to display the new Machine Tool Collisions 
dialog. The Machine Tool Collisions dialog displays any collisions that 

occur when you simulate or jog the machine tool. 

 
 



 

90 • User interface PowerMILL 2014 R2 What's New  

The new Machine Tool Collisions dialog 

The new Machine Tool Collisions dialog has the same user interface 

as the Machine Collisions tab in previous versions of PowerMILL. To 

display the dialog, click  on the: 

 Machine Tool Toolbar 

 Machine Tool Position dialog 
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Macro programming 
The macro programming language has a number of enhancements. 
You can now: 

 Use commands and functions to create, edit and delete files and 
directories. 

 Extract data from lists using more succinct expressions. 

 Quickly and easily determine the name of active folders. 

 Automate a sequence of edits, for example to a number of 
template projects. 

 Sort lists and arrays of scalars (numerics or strings) or objects 
and entities in ascending or descending order. 

For more information, see the Macro Programming Guide. 

 

Automation 
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Creating custom toolbars 
There is an improved process for creating and managing custom 
toolbars. In PowerMILL 2014R2 you can also have up to thirty-two 

custom toolbars at any time. 
 

Creating and managing custom toolbars 

To display the new Customise dialog, from the View menu, select 

Toolbar > Custom > Customise. 

 

 Create toolbar — Click to create a new toolbar.  

 The button is unavailable if you reach the maximum number 

of thirty-two toolbars then. 

 Delete toolbar — Click to permanently delete the selected 

toolbar(s). 

General enhancements 
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 Edit selected toolbar — Click to display the Edit Custom Toolbar 

dialog. The dialog enables you to add, remove, and edit the buttons 

on the selected toolbar (see page 94). 

 Select all toolbars — Click to select all toolbars. 

 Deselect all toolbars — Click to deselect all toolbars. 

 Toggle toolbar selection — Click to switch the toolbar selection so 

selected toolbars are deselected and deselected toolbars are 
selected. 

 Display selected toolbar(s) — Click to display the selected 

toolbars. 

 Hide selected toolbar(s) — Click to hide the selected toolbars that 

are currently displayed. 

Sharing toolbars 

PowerMILL 2014R2 has import and export options that enable you 

to share custom toolbars: 

 The Import toolbar  and Export toolbar  buttons let you 

share toolbars between PowerMILL 2014R2 and future versions 
of PowerMILL. The two seats of PowerMILL can be installed on 

the same or different PCs. 

 The Import from older version  and Export to older version  

buttons are legacy functions. The functions let you share custom 

toolbars between PowerMILL 2014R2 and older versions of 
PowerMILL. To share the toolbars, both versions of PowerMILL 

must be installed on the same PC. 

 Import toolbar — Click to import toolbars created by another 

PowerMILL user. 

 Export toolbar — Click to export the selected toolbars so you can 

share them with another PowerMILL user. 

 Import from older version — Click to import custom toolbars 

created in a previous version of PowerMILL. 

 Export to older version — Click to export custom toolbars to use 

in an older version of PowerMILL. 

 The appearance and behaviour of a toolbar does not change 

when you import or export it to a different version. 

 The legacy options are temporary. 
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Adding buttons to toolbars 

The old Customise dialog features an updated design and is now 

called the Edit Custom toolbar dialog. 
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